Enterprise Services Repository

Planning and Performing Enterprise Services Repository Installation and Update Based on SAP NetWeaver Composition Environment 7.1

Target Audience

- System administrators
- Technology consultants

Document version: 1.1 - 05/16/2008
Material number: 50086788
Document History

⚠ Caution
Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at the following location: [http://sdn.sap.com/irj/sdn/nw-esr](http://sdn.sap.com/irj/sdn/nw-esr).

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>5/16/2008</td>
<td>SR5</td>
</tr>
</tbody>
</table>
# Table of Contents

*Chapter 1*  
Introduction .......................................................... 5

*Chapter 2*  
Planning the Enterprise Services Repository for SAP NetWeaver Composition Environment ........................................... 7

*Chapter 3*  
Installing SAP Enterprise Services Repository ............................. 11

*Chapter 4*  
Post-Installation Activities .................................................. 15

*Chapter 5*  
Updating the ES Repository System ......................................... 19
1 Introduction

This document explains how to implement the Enterprise Services Repository (ES Repository) for SAP NetWeaver Composition Environment. For more information about the Enterprise Services Repository, see SAP Community Network (SDN) at http://www.sdn.sap.com/irj/sdn/nw-esr (SDN user required).
This page is intentionally left blank.
2 Planning the Enterprise Services Repository for SAP NetWeaver Composition Environment

Overview
The Enterprise Services Repository for SAP NetWeaver Composition Environment is an add-on product and an important cornerstone to develop applications that comply to an enterprise service-oriented architecture (enterprise SOA). The Enterprise Services Repository (ES Repository) supports a model-driven development that enables a top-down development of enterprise services for both service provisioning and service consuming. The ES Repository only supports point-to-point consumption of services in the system landscape of the SAP NetWeaver Composition Environment (SAP NetWeaver CE).

SAP applications that support this approach ship ES Repository content (ESR content) to enable customers the consumption of enterprise services. In particular, a global data type catalogue will be provided which is based on the Core Components Technical Specification standards to ensure a high degree of reusability.

Use Cases
The first step of an enterprise SOA based development comprises the modeling and definition of all necessary service interfaces of an application in the ES Repository. Based on these service interface definitions you can create runtime counterparts by means of a proxy generation in SAP NetWeaver Developer Studio of SAP NetWeaver CE.

There are two main use cases of the ES Repository which follow this approach:

- Providing enterprise services
  This use case comprises all necessary steps to develop a service and to offer it for consumption: The service interface definition in the ES Repository, the service implementation on AS Java and the service publication to the Services Registry of SAP NetWeaver CE.

- Consuming enterprise services
  This use case comprises all necessary steps to consume an existing service point-to-point: The service interface definition in the ES Repository, the implementation of the service call on AS Java and the service configuration. You can either consume a service provided by SAP or your own service.

The discovery of services of a service provider is the main use case of the Services Registry of SAP NetWeaver CE. The steps to discover a service that was published from the ES Repository are basically the same.
System Landscape
The following graphic shows the Enterprise Services Repository after its installation as add-on product for SAP NetWeaver CE. When used, the data of the ES Repository can be closely coupled with data in the Services Registry of SAP NetWeaver CE.

Figure 1: System Landscape for Enterprise Services Repository for SAP NetWeaver Composition Environment

- As a prerequisite for development in the ES Repository, the System Landscape Directory is needed where products and software components are maintained. After an installation of the Enterprise Services Repository for SAP NetWeaver CE, you can create your own products and software component versions in the System Landscape Directory.
- You access the ES Repository by means of the Enterprise Services Builder, a WebStart UI client. Before start of development software component versions need to be imported from the System Landscape Directory into the ES Repository.
- You can publish services to the Services Registry either after the definition and the release of a service interface by means of the service interface editor in the ES Builder or after the service configuration in the SAP NetWeaver Administrator.
- To provide a service, you access the ES Repository by means of the SAP NetWeaver Developer Studio to get the service interface definition and to implement the service. To consume a service point-to-point, you access the Services Registry by means of the SAP NetWeaver Developer Studio and implement the service call.

We recommend that you use one Enterprise Services Repository in your system landscape that runs on the same AS Java as the Services Registry of SAP NetWeaver CE.
Note
SAP NetWeaver Process Integration 7.1 also offers an ES Repository. We recommend that you use that one in case you purchased SAP NetWeaver Process Integration 7.1 in addition to SAP NetWeaver CE 7.1. Existing ESR content of the ES Repository for SAP NetWeaver CE can be transported to the ES Repository of SAP NetWeaver Process Integration 7.1.

More Information
For more information about how to plan and install SAP NetWeaver Composition Environment 7.1, see the documentation SAP NetWeaver Composition Environment 7.1 Master Guide at http://www.sdn.sap.com SAP NetWeaver Composition Environment.
This page is intentionally left blank.
3 Installing SAP Enterprise Services Repository

This section provides information about the steps that you have to perform to install SAP Enterprise Services Repository (ES Repository).

Prerequisites
You have installed an SAP NetWeaver Composition Environment (CE) system.

SAP Notes for the Installation
Make sure you have read the latest version of SAP Note 1070101 before you start the installation. This SAP Note contains the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note, which you can find on SAP Service Marketplace at http://service.sap.com/notes.

Hardware and Software Requirements
Before starting the installation, make sure you meet the hardware and software requirements for your operating system (OS) and the ES Repository system.
Consider the following information:

- For supported operating system releases, see the Product Availability Matrix on SAP Service Marketplace at http://service.sap.com/pam.
- Contact your OS vendor for the latest OS patches.

If you want to install ES Repository, the host must meet the hardware and software requirements as described in the documentation Installation Guide — SAP NetWeaver Composition Environment 7.1 SP05, available at http://www.sdn.sap.com/irj/sdn/nw-ce.

Preparing the Installation DVD
Make sure you have the installation DVD for ES Repository available.
You can also download the installation DVD from SAP Service Marketplace at:
If you download the installation DVD, note that the DVD may be split into several archives. In this case, you have to unpack these archives to one folder after the download.
Installing the ES Repository System
This procedure tells you how to install an SAP system with SAPinst. SAPinst includes a SAPinst GUI and a GUI server, which both use Java. This section describes an installation where SAPinst, SAPinst GUI, and the GUI server are running on the same host.

Note the following information about SAPinst:

- When you start SAPinst, SAPinst GUI and the GUI server also start. SAPinst GUI connects to the GUI server with a secure SSL connection, and the GUI server connects to SAPinst.
- SAPinst normally creates the installation directory sapinst_instdir, where it keeps its log files, and which is located directly in the Program Files directory. If SAPinst is not able to create sapinst_instdir there, it tries to create sapinst_instdir in the directory defined by the environment variable TEMP.

Recommendation
We recommend that you keep all installation directories until the system is completely and correctly installed.

- SAPinst creates a subdirectory for each installation service called <sapinst_instdir><installation_service_directory>, which is located in %ProgramFiles%.
- The SAPinst Self-Extractor extracts the executables to a temporary directory (TEMP, TMP, TMPDIR, or SystemRoot). These executables are deleted after SAPinst has stopped running. Directories called sapinst_exe.xxxxxx.xxxx sometimes remain in the temporary directory. You can safely delete them. The temporary directory also contains the SAPinst Self-Extractor log file dev_selfex.out, which might be useful if an error occurs.

Caution
If SAPinst cannot find a temporary directory, the installation terminates with the error FCO-00058.

- If you want to terminate SAPinst and the SAPinst Self-Extractor, choose one of the following options:
  - Right-click the icon for the SAPinst output window located in the Windows tray and choose Exit.
  - Click the icon for the SAPinst output window located in the Windows tray and choose File ➤ Exit ➤.

Prerequisites

- Before you start the installation, make sure that no http proxy settings are set in the system. You can check that in the SAP NetWeaver Administrator at http://<host>:<httpport>/nwa ➤ SOA Management ➤ System Global Settings ➤ HTTP Proxy Settings ➤.
- You are logged on as a user with administration rights to install the SAPinst tool and the SAP system.
  - Linux/ AIX: Log on to your host as user root.
**Note**

When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, ce1adm). During the installation SAPInst does a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

**Procedure**

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. **Windows**: Start SAPInst from the SAP Installation Master DVD by double-clicking sapinst.exe from the following path: `<DVD drive>:\DATA_UNITS\IM_WIN_<platform>_<database>.
   **Linux/ AIX**: Enter the following commands: cd <Installation Master_DVD>/IM_<OS>_<database> ./sapinst
   SAPInst GUI starts automatically by displaying the Welcome screen.
3. Follow the screens and enter the required parameters.

**Note**

For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press `F1`

After you have entered all requested input parameters, SAPInst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPInst set by default. If required, you can revise the parameters before starting the installation.

4. To start the installation, choose Start. SAPInst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPInst shows the dialog Execution of `<Service_Name>` has been completed successfully.

**Note**

The ES Repository offline documentation is installed automatically. You can access it by choosing Start ▶ All Programs ▶ SAP NetWeaver Composition Environment ▶ `<CE_SAPSID>` ▶ ESR documentation.
This page is intentionally left blank.
4 Post-Installation Activities

**Activating Configuration Templates**

Configuration templates contain the predefined instance configuration for specific scenarios. They are automatically applied according to the installation option you have selected. The templates are designed to optimize system performance by applying certain configuration to the Java Virtual Machine and the application server, as well as by applying startup filters to AS Java services and applications to start only those relevant for the selected installation options.

You must apply additional configuration steps to enable ES Repository after you have installed an SAP NetWeaver Composition Environment system. To enable ES Repository, you must apply the following configuration templates to your system:

<table>
<thead>
<tr>
<th>Configuration Template</th>
<th>Mode of SAP NetWeaver CE system</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_Engineer_Services_Repository_production_full</td>
<td>Productive mode</td>
</tr>
<tr>
<td>CE_Engineer_Services_Repository_development_full</td>
<td>Development mode</td>
</tr>
</tbody>
</table>

For more information about applying configuration templates, see [http://help.sap.com/nwce](http://help.sap.com/nwce). In section SAP NetWeaver Composition Environment 7.1 Knowledge Center choose: Installation and Configuration ➤ Configuration of SAP NetWeaver CE ➤ Advanced Configuration Tasks ➤ Activating a Configuration Template ➤

⚠️ **Caution**

Make sure that you do not apply a template for a development system to a productive system or vice versa.

**Activation of all CE applications after the ES Repository Installation**

After the installation of ES Repository, only the ES Repository and CE basis applications and services are running. If you need to activate all CE applications, change the configuration template to one of the following templates, depending on your CE system.

- CE_Complete_Stack_development_full or
- CE_Complete_Stack_production_full

⚠️ **Note**

You need to apply the template **before** running the configuration wizard.

For more information about how to change configuration templates, see

[http://help.sap.com/nwce](http://help.sap.com/nwce) ➤ SAP NetWeaver Composition Environment 7.1 ➤ Administrator’s
Running the Configuration Wizard
After SAPInst has finished, run the configuration wizard to apply automated configuration tasks to your system. For ES Repository, you need to run the following configuration tasks:

1. **Initial Setup of functional unit SLD**

   - **Note**
   - You need to restart the engine after running the SLD configuration task.

2. **Configuration of ESR in CE**

   - **Note**
   - If the configuration of ESR in CE fails during the step Importing XI content, apply SAP Note 1144861.

For more information about how to start the configuration wizard, see the configuration documentation in the SAP Solution Manager.

Updating SLD Content (Local SLD Only)
If you are using a local SLD, update the SLD content as described in SAP Note 669669.

Installing the Plug-In Documentation (Optional)

Prerequisite


Procedure

2. Unzip the file esr_docu_plugin.zip.
   - You get the file com.sap.netweaver.developerstudio.xpi.ecf.
4. Add your temporary directory as local update page in your SAP NetWeaver Developer Studio by choosing Help > Software Updates > Find and Install.
The ES Repository documentation is now visible in your SAP NetWeaver Developer Studio by choosing Help > Help Contents.

**Starting the Enterprise Services Repository**

You can start the ES Repository using the following link in a browser:

http://<host_name>:<http_port>/rep

To start the frontend of the ES Repository, choose the Enterprise Services Builder. For more information about how to create users for the Enterprise Services Builder (ES Builder), see

http://help.sap.com/nwce > Enterprise Services Repository for SAP NetWeaver CE 7.1 > Administrator’s Guide > Technical Operations > System Management > Creating Users. You can also use the existing user ESRAadmin if you created it before for the purpose of manual configuration.

**Note**

The Enterprise Services Repository contains object types that are relevant for both SAP NetWeaver Process Integration and SAP NetWeaver Composition Environment. Only a subset of the object types are relevant for SAP NetWeaver Composition Environment, however. The object types displayed in the ES Builder are restricted to this subset by means of the Service Development application profile. If you do not install SAP NetWeaver Process Integration, the required SAP NetWeaver Process Integration configuration and runtime components (such as the Integration Directory and the Integration Server) will be missing and it will therefore not be possible to develop based on these object types.
5 Updating the ES Repository System

Prerequisites

- You have installed the ES Repository System for SAP NetWeaver Composition Environment (CE) 7.1 with SP03 or higher.
- You have updated your SAP NetWeaver CE system to SP06.

To update your ES Repository system to SP06, proceed as follows:

   - ESR 7.10
   - LM SLD 7.10
   - XI CONTENT SAP_BASIS 7.10
3. Copy or move the ESR-related SCAs and the `update<id>.exe` file used for the CE upgrade into one directory and start the update.

   ![Note](image)

   a) The directory should contain only ESR-related SCAs (ESR 7.10, LM SLD 710) and `update.exe`!
   b) The ES Repository upgrade does not support automatic upgrade using the Update Management Service (`ceupdatemanager.exe`).
   c) If the `update<id>.exe` is not available, download the CE update files (`update<id>.exe`) from [http://service.sap.com/swdc](http://service.sap.com/swdc) → Support Packages and Patches → Entry by Application Group → SAP NetWeaver → SAP NETWEAVER → SAP NETWEAVER CE 7.1 → Support Package Stacks.

4. Run the update tool and follow the on-screen instructions. After running the update tool wait until the engine is fully started.

Follow-Up Activities

After you successfully updated your ES Repository system, you need to import the Process Integration (PI) content from the downloaded file XI CONTENT BASIS 7.10 (from the archive `SAPBASIS<SP>_<PL>.ZIP`).

05/16/2008  PUBLIC  19/24
To do so, proceed as follows:

1. **UNIX:** Unpack the archive into the directory `/usr/sap/trans/EPS/in.
   
   **Windows:** Unpack the archive into the directory `<drive>:\usr\sap\trans\EPS\in`.

2. **UNIX:** Copy the export file with the file extension `.tpz` into the import directory
   `/usr/sap/<SAPSID>/SYS/global/xi/repository_server/import`.
   
   **Windows:** Copy the export file with the file extension `.tpz` into the import directory
   `<drive>:\usr\sap\<SAPSID>\SYS\global\xi\repository_server\import`.

3. Open the Enterprise Services Builder of your ES Repository system at
   
   `http://<host>:<port>/rep/start/index.jsp` | Enterprise Services Builder | and
   
   logon as a user assigned to group `SAP_ESR_ADMINISTRATOR` or `SAP_ESR_CONTENT_ORGANIZER`.

4. Import the PI/XI content by choosing `Tools` | Import design objects... |.

5. Follow the screens.
   
   If required, specify the location of the TPZ file (client or server)
# Typographic Conventions

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; &gt;</td>
<td>Angle brackets indicate that you replace these words or characters with appropriate entries to make entries in the system, for example, “Enter your <code>&lt;User Name&gt;</code>”.</td>
</tr>
<tr>
<td>Arrows</td>
<td>Arrows separating the parts of a navigation path, for example, menu options</td>
</tr>
<tr>
<td>Example</td>
<td>Emphasized words or expressions</td>
</tr>
<tr>
<td>Example</td>
<td>Words or characters that you enter in the system exactly as they appear in the documentation</td>
</tr>
<tr>
<td>Example</td>
<td>Textual cross-references to an internet address, for example, <a href="http://www.sap.com">http://www.sap.com</a></td>
</tr>
<tr>
<td>/example</td>
<td>Quicklinks added to the internet address of a homepage to enable quick access to specific content on the Web</td>
</tr>
<tr>
<td>123456</td>
<td>Hyperlink to a SAP Note, for example, SAP Note 123456</td>
</tr>
</tbody>
</table>
| Example | - Words or characters quoted from the screen. These include field labels, screen titles, pushbutton labels, menu names, and menu options.  
- Cross-references to other documentation or published works |
| Example | - Output on the screen following a user action, for example, messages  
- Source code or syntax quoted directly from a program  
- File and directory names and their paths, names of variables and parameters, and names of installation, upgrade, and database tools |
| EXAMPLE | Technical names of system objects. These include report names, program names, transaction codes, database table names, and key concepts of a programming language when they are surrounded by body text, for example, `SELECT` and `INCLUDE` |
| EXAMPLE | Keys on the keyboard |
© Copyright 2008 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft, Windows, Excel, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.

IBM, DB2, DB2 Universal Database, OS/2, Parallel Sysplex, MVS/ESA, AIX, S/390, AS/400, OS/390, OS/400, iSeries, pSeries, xSeries, zSeries, System i, System i5, System p, System p5, System x, System z, System z9, z/OS, AFP, Intelligent Miner, WebSphere, Netfinity, Tivoli, Informix, i5/OS, POWER, POWER5, POWER5+, OpenPower and PowerPC are trademarks or registered trademarks of IBM Corporation.

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Oracle is a registered trademark of Oracle Corporation.

UNIX, X/Open, OSF/1, and Motif are registered trademarks of the Open Group.

Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.

HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®; World Wide Web Consortium, Massachusetts Institute of Technology.

Java is a registered trademark of Sun Microsystems, Inc.

JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, R/3, xApps, xApp, SAP NetWeaver, Duet, PartnerEdge, ByDesign, SAP Business ByDesign, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary.

These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies ("SAP Group") for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.

This document was created using stylesheet 2006-12-31 (V5.1beta [= 6.0 for E3]) and XSLT processor SAXON 6.5.2 from Michael Kay (http://saxon.sf.net/), XSLT version 1.
Disclaimer
Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components. Any Java™ Source Code delivered with this product is only to be used by SAP's Support Services and may not be modified or altered in any way.

Documentation in the SAP Service Marketplace
You can find this document at the following address: https://service.sap.com/instguides